
User Guide  |  WIR-206 

Wireless Internet Radio 
Media Player from 





C U S T O M E R  C A R E  I N F O R M A T I O N

•
•
•

If you have trouble setting up or operating 
the Wireless Internet Radio / Media Player,
please do not return the unit until after
consulting the following web page and 
speaking with a customer service
representative to obtain Return
Authorization Instructions.

Thank you!

http://www.HisKids.net/solutions
Answers to your FAQs 

Complete Contact Information 

Current Channel Listings 

•
•
•

Downloadable User Guide 

Feedback Forms 

Free Firmware Upgrades **

•
•
•

News & Information 

Troubleshooting Tips

And much more!





W E LCO M E…

Note
If you have a wireless laptop available you can check that the

•
•
•

Introducing the Wireless Internet Radio  
(WIR) / Media Player powered by  
HisKids.net! 

The advanced technology in this device will bless your family 

by providing access to countless hours of Christian radio & 
adventure dramas especially for kids -- from virtually any

This guide has been written to provide a simple explanation
of all the information you need to get the most from your
Wireless Internet Radio/Media player.
What’s in the box:

The Wireless Internet Radio (WIR) / Media Player

AC power supply

User Guide
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If you have a wireless laptop available you can check that the 
wireless network is up and working.

•

•

room in your home! 

internet, preferably via a router.
If your wireless network is configured to use Wired Equivalent
Privacy (WEP) or WiFi Protected Access (WPA) data encryption
then you need to know the WEP or WPA code so you can get
the Internet Radio to communicate with the network.

The WIR should work in all locations where the WiFi network is
available. You will also need to know the name of your wireless
network, i.e. its ESSID.

Before you continue, make sure that your wireless access point
is turned on and connected to your broadband internet. To get
this part of the system working you may need to read the
instructions supplied with the wireless access point.

Before you can use your Internet Radio, you will need a 
wireless access point (WiFi) connected to your broadband
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Select

• Press to select a displayed option.

Back

• Press to go back to the previous display.

Shift

• This allows you to access the second level
of memory stores.  

Stop

• Press to stop playback.

• With a track name displayed, press and
hold to delete the track.

Play / Pause

• Press to Play/Pause playback.

Dial/Volume control
• Use to change the option shown

on the display.

• Use to adjust the volume.

On / Off

• Press to switch the Internet Radio On/Off.

Pre-Set buttons

• Use to play up to 10 radio stations/programs.

Browse

• Press to view the name of the track currently
playing and then turn the dial to see the list of
tracks waiting in the play queue.

• Can be used with a long press of the Stop key
to delete individual tracks from the queue.

Skip forwards

• Press to start playback at the next track.

Skip backwards

• Press to start playback at the previous track.

Dial/Volume control

The LEDs on the top case indicate the 'mode'
the wheel is in.  With the menu LED on, the
wheel is used to navigate through the menu.
With the volume LED on, it is used to control
the volume of your Wireless Internet Radio.

 THE WIRELESS INTERNET RADIO (WIR) / MEDIA PLAYER 
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Dial/Volume control
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GETTING STARTED WITH THE MEDIA PLAYER
In order to play the music files you have stored on your PC via
the “Windows Shares” and “UPNP Servers” of the Media Player,

• That your PC has the correct type of music files saved on it
(explained in the following paragraphs).

• The music files on your PC are not ‘protected’.

• That the music files are stored in the correct location on your PC.

• The PC has file sharing turned on.

• The music files can be ‘shared’ on the network.

• You know the Name of your PC.

The configuration of your PC and media files may already allow the
WIR to stream the media you have stored.  It is worth trying
to stream music from your PC first, then resolve any issues that
may arise rather than working through the following set up.

Music content
The Internet Radio plays the most popular music types:

File type File extension shown on PC
(These are the letters that appear
after the file name, e.g. Music.mp3)

MP3 .mp3
Windows Media .wma
Real .ra
iTunes (Unprotected) .aac
Ogg Vorbis .ogg

Windows normally hides the file extensions, so you may need
to turn on ‘View File Extensions’. This can be done from the
’Control Panel’, 'Folder Options' menu.
The option is labelled 'Hide extensions for known file types'
and is found in the 'View' tab.

CONTROL PANEL

FOLDER OPTIONS

VIEW TAB

MAKE SURE THE ‘HIDE
FILE EXTENSIONS FOR
KNOW FILE TYPES’ IS
NOT CHECKED

you must ensure the following:
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Note
If you are uncertain of the format of your music, please look
in the folder on your PC and ensure that the file extensions
are listed in the previous section.



Ensuring files are not protected
If you suspect an audio file is protected, you can confirm
this in Windows XP by finding the file on your PC and
right clicking on the file.  In Windows, click 'Properties'.
Protected files will have a 'License' tab which will say
'Protected Content'. If the WIR tries to play a protected file, the
display will say the file is 'Protected'.

XP Only

XP Pro with Media Player 10
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PROTECTED
CONTENT

DISABLE THE PERSONAL
RIGHTS MANAGEMENT
FEATURE BEFORE COPYING
YOUR CDS, AS IT WILL
PREVENT THE INTERNET
RADIO FROM PLAYING THE
STORED FILES.

DO NOT COPYRIGHT
PROTECT MUSIC OR YOU
WILL NOT BE ABLE TO PLAY
IT VIA THE INTERNET RADIO.

THIS IS FROM A WINDOWS
2000 MACHINE WITH
WINDOWS MEDIA PLAYER 7.
THIS SCREEN IS REACHED
FROM THE TOOLS PULL
DOWN AND THEN
SELECTING OPTIONS.

YOU GET HERE BY
SELECTING TOOLS FROM
WITHIN WINDOWS MEDIA
PLAYER, THEN OPTIONS.

Note

Unfortunately, Windows 2000 does not have the same
feature so it is not possible to check. The simplest solution is
to save a new file and ensure that the protection is off.



If the file is protected, you will NOT be able to play it on
the Media Player.

You will either need to un-protect it, or save it again with the
Personal Protection turned off.

Notes on Ripping Music

Sometimes when you put a CD into the PC it will display
‘Unknown Album’, ‘Unknown Artist’ and ‘Unknown Tracks’.
Obviously, this makes choosing media difficult. However, most
CD copy programs, like Windows Media Player 10, have an
option to find the information from the internet, so providing
you are connected to the internet, selecting ‘Find Album Info’
should update all of the information for  you.

Windows Media Player on XP Pro

Location of My Music Files
The simplest place to store your music is at the ‘top’ of the PCs
hard drive. This is normally referred to as the ‘root directory’.  To
find the root directory, go to ‘My Computer’ and find the ‘C:’
location.  This is the root directory and you should put your
music in a folder in this directory.
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FIND ALBUM INFORMATION

Note 
The default setting for Windows Media Player is that it will
automatically try to update the track information if the PC is
connected to an active internet connection.



To do this, go to the folder where the ‘My Music’ folder is
located; normally  C:\Documents and Settings\[Username]\My
Documents\My Music.

Then cut this folder and paste it to the root directory ‘C:\’.

Windows Media Player will still be able to play your music from
its new location, but you will need to tell Windows Media
Player to search and find the new location of your music. You
can do this by entering the 'Library' tab in Windows Media
Player and selecting 'Add to Library' from the 'File' menu.  You
can instruct Windows Media Player to search the entire drive
for media.

To ensure that Windows Media Player stores all future music
you save on your PC to the same folder in the root directory,
from within Media Player select the 'Rip Music' tab in the
'Options' dialog bar, found under the 'Tools' menu.
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THE ROOT DIRECTORY, C:
YOU SHOULD PUT YOUR
MUSIC FOLDER IN HERE

CHANGE TO THE ROOT
DIRECTORY, C:\

Note
If you have copied music to your hard drive using
Windows Media Player, it will have stored the files in the ‘My
Music’ folder.  Unfortunately this is a protected folder and
cannot always be ‘shared’, so you will need to move the
content to the root directory.  Similarly, music files cannot
be shared from the CD Drive.

Note
If the 'File' and 'Tools' menus are hidden, right click near 
the top of Windows Media Player and select 'View', 'Menu
Bar Options', 'Show Menu Bar' from the context menu.



If you are using iTunes, by default the CD copy software
stores the music to:

c:\Documents and Settings\Home(name of your computer
user)\My Documents\Music\iTunes\iTunes Music.

PC File Sharing
Follow the instructions shown in ‘Sharing Files’ (see page 24),
if the Sharing option is not highlighted (not available for
selection), you will need to enable Global File Sharing as
described in this section.

In Windows XP there is a Wizard which does the configuration
for you. In the 'Control Panel',  select 'Network Connections',
select File and ‘Network Set Up Wizard’. The wizard is called 'Set
up a home or small office network'.

In Windows 2000, ensure that ‘File and Printer Sharing for
Microsoft Networks’ is installed. This can be verified by
selecting ‘Properties’ on the LAN connection from ‘Network and
Dial-up connections’ in the Control Panel.

Windows 2000
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CHANGE TO THE ROOT
DIRECTORY, C:\

CHANGE TO THE ROOT
DIRECTORY, C:\





You may need to enter a ‘Share Name’ (Windows sometimes
does this automatically). You can enter any name you want,
and once the Internet Radio has found the folder with your
music in it, the radio will display the share name rather than
the folder name.

When the folder is shared, the folder icon will be shown with a
cupped hand holding the folder:

Your PC Name
When you search on the Internet Radio for PCs, it will identify
your PC by its name. To confirm the name of your PC, go to the
‘Control Panel’ and select ‘System’ and then the ‘Network
Identification’ tab:

Windows 2000
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CUPPED HAND UNDER
FOLDERS, SHOWING
THEY ARE SHARED

CONTROL PANEL

SELECT SYSTEM

NETWORK
IDENTIFICATION TAB

COMPUTER NAME, IN THIS CASE
Dave's PC

Note 
If you only have one PC on the network, then there is no  
need to check the name as it will be the only one on the  
network. 



1

2

3

Set up your MAC to allow the WIR to  
access your audio files

1 Double click on 'System Preferences' on the 'Dock', then select
'Sharing' in the 'Internet & Network' section.

Click 'Windows Sharing' in the 'Services' section to enable
Windows filesharing. Within the window you should see
'Windows Sharing On' (and a STOP button), this indicates
windows sharing is activated.

2 Click the 'Accounts...' button when 'Windows Sharing' is
activated, then check the accounts for which sharing will be
enabled. Click DONE and close the Window.

3 With the 'Finder' menu displayed, select 'Utilities' from the
Go Menu, then double-click on  'Directory Access'.

Enable 'SMB/CIFS', and click 'Configure...'. Enter a workgroup
name in here and click on 'Apply'.
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CONTROL PANEL

SELECT THE SYSTEM
ICON AND THEN THE
COMPUTER NAME TAB

COMPUTER NAME

XP Home

Note

The view of Control Panel shown here is Classic.  An
alternative view showing ‘Categories’ is also available.  In this
view, select ‘Performance and Maintenance’, and then
‘System Properties’.

Note

If the Enable options are not highlighted for selection, click
the Lock symbol in the bottom left of the window, enter your
password and press OK.
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Instructions for PC streaming
Select Media Player on the WIR.

Switch on the Internet Radio and press BACK until you are at the
top level menu. Turn the dial until Media Player is displayed
and press the SELECT button.

2 Turn the dial to choose from <Windows Shares> or
<UPNP Servers>. 

Windows Shares

Finding folders

The Internet Radio will now scan the PC you have selected and
display a list of any folders which have ‘sharing’ enabled.

Turn the dial to select the folder that contains the saved music,
and press the SELECT button.

Selecting music

You can now view the content of the shared folder by Album or
Artist. Use the dial to move through the list.

Adding music to the queue and managing the queue.

When you select music to be played, it is added to the Play
queue, and played sequentially. The queue can be stopped or
viewed by pressing the queue play control keys (underneath
the 1.6, 2.7, 3.8, 4.9, 5.10 buttons).

A single track can be deleted from the queue by browsing the
queue and then pressing and holding the STOP button for
more than 2 seconds, or the entire queue can be deleted from
the top level menu.
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‘Scan for PCs’ is displayed, press the SELECT button. Your
computer network will scan and a list of all available PCs will be
displayed on your Internet Radio.

Turn the dial to highlight the PC you want to play music from

and press the SELECT button.

1

2

Press the SELECT button to choose <Windows Shares>.  When

Note
If a PC does not have global file sharing turned on or a third
party firewall is protecting the PC, it will not be visible when
you scan for it.  Please refer to the Troubleshooting section in
this document to overcome this problem.

Note
You may be asked to enter a username and password to
access the PC you have selected. This is the same user name
and password you would enter if actually sitting in front of
the computer.

Note
Your PC may have folders shared which do not contain music.
The Internet Radio is just searching for shared folders, so will
find all shared folders, regardless of content.









Playing tracks in random order
1 Select the individual tracks as described previously and place

them in the queue.

2 Navigate to the top level menu of the Media Player  using the
SELECT and BACK buttons.

Press the SELECT button.

4 Turn the dial until PlaybackMode is displayed.

Press the SELECT button.

Turn the dial until Shuffle is displayed.

Press the SELECT button.

8 Turn the dial to select YES to confirm that shuffle mode should
be enabled. This will shuffle the existing queue and shuffle any
new tracks that are added. However, if when the WIR has a
shuffled queue, the customer turns off the shuffle feature, the
current queue is NOT unshuffled, but any new tracks are not
shuffled.

Playing tracks in the queue repeatedly
1 Select the individual tracks as described previously.

2 Navigate to the top level menu of the Media Player  using the
SELECT and BACK buttons.

3 Press the SELECT button.

4 Turn the dial until PlaybackMode is displayed.

5 Press the SELECT button.

6 Turn the dial until Repeat is displayed.

7 Press the SELECT button.

8 Turn the dial to select YES to confirm that repeat mode should
be enabled.

9 To turn off selected tracks return to the same menu option;
Repeat or Shuffle .

10 You will be asked if you wish to Disable , Yes or No.

11 Press the SELECT button.
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Scan Error:

• When the Internet Radio is scanning the content of the folders
on a PC, it is possible that a scan error may occur if the
Windows file sharing application times out. This is most likely
to occur if both the PC with the media content and the Internet
Radio are connected wirelessly.

Try reconnecting the PC with the media content into the
network with a cable. This will dramatically increase the speed
at which the WIR is able to scan the content of the Media PC.

Playlists:

• Some media ripping applications allow ‘Playlists’ to be created.

The WIR is able to detect and stream these playlists, but they
must be stored in the folder with the rest of the media content
and they must have the file extension .m3u.

Windows Media Player can create suitable playlists. Just select
‘create new playlist’, drag and drop the tracks you want into the
playlists, then use ‘Save As’ to ensure the file type is .m3u.
(Existing playlists can be opened and resaved in this format.)

When the WIR detects you have playlists, it will enable a new
menu option allowing the playlist to be selected and added to
the queue.

If you reconnect to another PC or folder which does not have
any playlists in the .m3u format, the playlist option will not be
presented in the menu.

If the WIR keeps rebuffering radio stations:

• The WIR is streaming data from the radio stations via your
broadband connection.  If there is a high error rate on your
broadband connection or the connection is intermittent,
it will cause the WIR to pause until the connection is re-
established and it has received enough data to start playing
again.

If your WIR keeps stopping, please check the DSL modem to
ensure that the broadband line is not suffering a high error rate
or disconnections.  If you are experiencing these problems, you
will need to contact your broadband supplier.

What is Buffering?

When playing a stream, the Wireless Internet Radio/Media Player
downloads a small amount of the stream before it starts
playing.  This is used to fill in any gaps in the stream that may
occur if the internet or the wireless network is busy.

• The Internet Radio streams music data from the PC while you
are listening. If a stream gets blocked or experiences network
congestion while transferring, it may stop/interfere with the
quality of play. If this happens, check your wireless connection
speed – it must be faster than the speed of the streams.
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